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ご注意

●　本書の内容の全部または一部を無断で転載あるいは複製することは、 法令で別段の定めがあるほか、 禁	

　　　じられています。

●　本書の内容および製品仕様について、 改良などのため将来予告なく変更することがあります。

●　本書の内容につきましては万全を期して作成しておりますが、万一記載漏れや誤り、理解しにくい内容など、

　　　お気づきの点がございましたらご連絡くださいますようお願い致します。

●　本機を使用したことによるお客様の損害、 逸失利益、 または第三者のいかなる請求につきましても、 一切

　　　のその責任を負いかねます。

　　　また、 本製品を使用中にデータなどが消失した場合や、 記録したデータが壊れていた場合でも、 データ　

　　　などの保証は一切いたしかねますのであらかじめご了承ください。

使用限定について

本製品は計測機器として使用されることを目的に、 開発製造されたものです。 原子力設備や

機器、 航空宇宙機器、 医療機器、 輸送設備や機器など故障や誤動作が人命に関わる設備

や機器、 及び高度な信頼性を必要とする設備や機器と組み合わせて使用されることは意図さ

れておらず、 また保証していません。 このような用途で使用される場合は、 お客様の責任に

おいてフェールセーフなどの安全対策へのご配慮をいただくとともに当社営業担当者までご相

談ください。

このたびは LE シリーズをお買いあげいただき、 誠にありがとうございます。 本機を正しくご利

用いただくために、 このユーザーマニュアルをお役立てください。 なお、 このユーザーマニュ

アルと保証書は、 必ず保管してください。 万一使用中にわからないことや具合の悪いことが

起きた時、 きっとお役に立ちます。

Copyright ２００７　by LINEEYE CO.,LTD. All rights reserved.

《第七版　2012.Mar》

はじめに
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必ずお読みください！！

この 「安全のためのご注意」 には、 対象製品をお使いになる方や、 他の人への危害と財産の損害を未然に防ぎ、 安全

に正しくお使いいただくために重要な内容を記載しています。

ご使用の前に、 次の内容 （表示 ・図記号） を理解し、 記載事項をお守りいただき正しくお使いください。

〔表示の説明 （安全注意事項のランク）〕

安全のためのご注意

誤った取り扱いをすると、 人が死亡または重傷を負う可能性が想定される内容を示します。

誤った取り扱いをすると、 人が傷害 *1 を負うまたは物的損害 *2 が発生する可能性が想定される

内容を示します。

*1 ： 傷害とは、 治療に入院や長期の通院を要さない、 けが、 やけど、 感電などをさします。

*2 ： 物的損傷とは、 家屋、 建築物、 家具、 装置機器、 家畜、 ペットにかかわる拡大損傷をさします。

■　本製品を分解したり、 改造しないで下さい。

　　火災 ・感電 ・動作不良の原因となります。

■　煙が出たり、 異臭、 異音がする場合は、 直ちに使用を中止してください。

　　そのまま使用すると火傷や火災、 感電の危険があります。

■　水などで濡らさないでください。

　　発熱、 感電、 故障の原因となります。

■　劣化 （破損など） したケーブル類は使用しないでください。

　　発熱し、 出火する危険があります。

■　引火性ガスなどの発生場所では使用しないでください。

　　発火の原因となります。

■ 本製品は以下のような場所で使用もしくは、 保管しないで下さい。

・ 不安定な場所や振動の多いところ

  落下等によるけがや故障の原因となります。

・ 使用範囲を超える温湿度や急激な温度変化のあるところ

  高温や結露により故障の原因となることがあります。

・ 直射日光の当たるところ

  50℃以上の高温となり、 火傷や故障の原因となります。 	

・ 水気や埃が多いところ

・熱を発生するものの近く （ヒーター、 電熱器、 ストーブなど）

  故障やケガの原因となります。
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ソフトウェア使用権許諾契約書

株式会社ラインアイ （以下 「弊社」 といいます） は、 本契約書とともにご提供するソフトウェ

ア ・ プログラム及び付随ドキュメント （以下 「本ソフトウェア」 といいます） を使用する権利を

本契約書の条項にもとづき許諾し、 お客様も本契約書の条項にご同意いただくものとします。

１． 著作権

本ソフトウェアの著作権は弊社が所有しています。

２． 使用権の範囲

弊社は、 お客様が本ソフトウェアを受領し本契約に同意した日から本ソフトウェアを１台のコン

ピュータで使用する権利をお客様に対してのみ許諾します。 よって、 本ソフトウェアの第三者へ

の譲渡、 貸与、 賃借は許諾しないものとします。

３． 複写 ・解析 ・改変について

お客様が本契約書に基づき、 弊社から提供された本ソフトウェアをマニュアルに規定してある場

合を除いて、 いかなる場合においても全体的または部分的に複製 ・ 解析 ・ 改変することはでき

ないものとします。

４． バージョンアップ

本ソフトウェアは、 ハードウェアやソフトウェアの技術的進歩により、 事前の予告なしにバージョ

ンアップすることがあります。 お客様は弊社が別途定める料金を支払うことにより、 本ソフトウェ

アのバージョンアップ品を受取り使用することができます。 なお、 バージョンアップは、 本契約

の使用権を同意されたお客様に限られます。

５． 弊社の免責

本ソフトウェア及び関連ソフトウェアによる生成物が、 直接または間接的に損害を生じても、 弊

社は一切の責任は負いません。 また、 機器や媒体が原因の損害に対しても、 弊社は一切の

責任は負いません。 さらに、 本ソフトウェアを使用した結果の影響に関しても一切の責任を負わ

ないものとします。

６．一般事項

本契約のいずれかの条項またはその一部が法律により無効となった場合は、 かかる部分は本

契約から削除されるものとします。

７． 本ソフトウェアのサポートについて

弊社のサポートの範囲は、 本ソフトウェアの機能、 操作面、 本ソフトウェアのみに起因する問

題に限らせていただきます。

８． その他

別段に定めのない事項については、 著作権法および関連法規に準拠するものとします。
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ご使用の前に

LE-580FX は、 10/100BASE-TX の全二重双方向パケットをキャプチャー及びモニター可能なタップ （TAP） モードと、

最大 100Mbps ラインレートのトラフィックを生成可能なパケットジェネレータ (PG) モードを持つ、コンパクトなネットワー

クテストツールです。

○商品構成

    開梱の際は、 下記のものがそろっているかご確認ください。

LE-580FX 本体	 	 	 	 ： 1 台

ユーティリティ CD  		 	 	 ： 1 枚

Mini - ＵＳＢケーブル	 	 	 ： 1 本

ＵＳＢ分岐ケーブル	 	 	 ： 1 本

ユーザーマニュアル	 	 	 ： 1 部 ( 本冊子 )

保証書	 	 	 	 	 	 ： 1 通

注） 万一、 輸送中の損傷や不足品がございましたら、 お買い上げの販売店または当社までご連絡ください。

注） 箱は大切に保管し、 修理などの輸送の時にご利用下さい。

     ●　ユーティリティＣＤについて

解析ソフトウエア、 ドライバ、 アナライザ本体および最新の取扱説明書などが収録されています。
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1. インストールとアンインストール

1.1. ドライバのインストール

LE-580FX を初めて PC に接続した際、 ドライバを要求されるので、 以下の手順でインストールします。

＜ Windows 2000/XP の場合＞

1)　LE-580FX 本体をホスト PCの USB ポートに接続するとウィザードが起動されるので、 「いいえ、 今回は接　

　　続しません」 を選び、 「次へ」 をクリックしてくだ さい。

2)　「検索しないで、 インストールするドライバを選択する」 を選び、 「次へ」 をクリックします。

3)　「ネットワークアダプタ」 を選択し、 「次へ」 をクリックします。
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4)　 「ディスク使用」 をクリックして、CD ドライブ内のドライバファイル “LE580FX.INF” を指定し、「OK」 を押してウィ

　　ザードの画面に戻ってから 「次へ」 をクリックします。

※ドライバは、 CDの 「Driver」 フォルダ以下でWindows 2000 と XP 用、 Windows Vista 用、 Windows 7 用

に分かれており、 2000 と XP 用は 「2000XP」、 Vista 用は 「Vista」、 7 用は 「Windows7」 のフォルダに入っ

ています。

2000 と XP、 Vista については、 インストール先のOS に応じてフォルダを選択してください。

5)　警告のメッセージが出ますが、 システム動作への影響はありませんので 「続行」 をクリックしてください。
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7)　インストールが完了したら 「完了」 をクリックしウィザードを終了します。

8) インストールの確認をします。

 「ローカルエリアの接続」 のプロパティ、 またはデバイスマネージャの 「ネットワークアダプタ」 で、 LE-580FX 

のドライバがインストールされていることを確認します。

6)　 ドライバーのインストールが開始されます。
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＜Windows Vista の場合＞ 

1)　LE-580FX 本体をホスト PCの USB ポートに接続するとウィザードが起動されるので、 「このデバイスについ

て再確認は不要です」 をクリックしてくだ さい。

2)　デバイスマネージャーで 「AX88178」 を右クリックし、 「ドライバソフトウエアの更新」 を選択します。

　　* デバイスマネージャーの表示：Windows の 「スタート」 -> 「コントロールパネル」 -> 「システムとメンテナンス」

　　-> 「システム」　-> 「ハードウエア」 -> 「デバイスマネージャー」 の順でクリックすると表示されます。

3)　「コンピューターを参照してドライバソフトウエアを検索します」 を選び、 「次へ」 をクリックします。

ここからは、 2000 や XP の場合の３以降とほぼ同じです。

* 途中で以下のメッセージが出るので、 「このドライバソフトウエアをインストールします」 を選択してください。
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1.2. アプリケーションソフトウェアのインストール
LE-580FX Window （LE-580FX を制御する基本ソフトウェア） をインストールします。 “LE-580FX window.exe”

を実行するとインストールが始まり、 同時にWinPcap （Windows 用のパケットドライバ） も同時にインストールさ

れます。

注 1） システムにファイヤーウォール / アンチウィルスソフトがインストールされている場合、 LE-580FX か

　　　　らホスト PCへのデータ転送がブロックされる場合があります。 ブロックされる場合は、 これらのソフ

　　　　トウェアの設定を変更して下さい。

注 2）　LE-580FX Window と LE-580FX QoS は、 WinPcap Ver4.1.1 にのみ対応してます。 LE-580FX  Window  ま　

　　　　たは LE-580FX QoS のインストール時には、WinPcap Ver4.1.1 もインストールされます。 すでに異なるバー

　　　　ジョンの WinPcap をインストールしている場合は、 それをアンインストールしてから、 LE-580FX のソフトウ

　　　　ェアをインストールしてください。

1.3. アプリケーションソフトウェアのアンインストール
Windows のスタートメニューから、 プログラム （すべてのプログラム） ->Lineeye->LE-580FX->LE-580FX 

Window->Uninstall LE-580FX Window を選択します。

あるいは、 コントロールパネルで、 プログラムのアンインストール / プログラムの追加と削除 / アプリケーション

の追加と削除から、 LE-580FX Window を削除することもできます。

注） LE-580FX Window の詳細については付属 CD内の PDF をご参照ください。

＜ Windows 7 の場合＞ 

付属 CDの 「Driver」 フォルダにある 「ReadMe(Windows7)_J.txt」 をご参照ください。
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LED の各ステータス

注）

*1　デフォルト設定では TAP モードです。

*2　TAP/PG の LED は、 ポート A ・ B どちらかがリンク状態になれば点灯します

　　 （緑 ： TAP、 オレンジ ： PG）。

*3　TAP モードでオートネゴシエーションが失敗した場合、 TAP/PG の LED が点滅し、

　　　Link/Tx の LED に通信スピー ド状態が表示され、 Rx/Err の LED に双方向状態

　　　が表示されます。

2. 各部の説明 ＜背面＞

Mini-USB ポート	 ： 　USB ケーブルを通じてホスト PC と接続

ポート A　	 ： 　テスト対象機器と接続する RJ-45 コネクタ

ポート B　	 ： 　テスト対象機器と接続する RJ-45 コネクタ

＜前面＞

Mini-USB （B） ポート

項目 LED の点灯色 状態

　PWR 緑 電源ON

　TAP/PG*2

緑 TAP モード *1

オレンジ PG モード

緑 （点滅） オートネゴシエーション失敗 （TAP モード）

　Link/Tx

緑 100M ｂｐｓでのリンク確立

オレンジ 10M ｂｐｓでのリンク確立

緑 （点滅） 100M ｂｐｓで (Tx) 通信中

オレンジ （点滅） 10M ｂｐｓで (Tx) 通信中

　Rx/Err

緑 *3 全二重通信

オレンジ *3 半二重通信

緑 （点滅） (Rx) 通信中

オレンジ （点滅） (Rx) 通信中 （CRC エラー）
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3. 仕様と動作環境

3.1. 仕様

※延長及び電源供給用に使用できます。

3.2. 動作環境

USB2.0 ポートのある PC/AT 互換機 （DOS/V 機）

CPU　: Pentium4 プロセッサー 1.6GH ｚ　以上 ( 推奨 )

RAM　: 256M バイト以上 ( 推奨 )

HDD　: 10G バイト以上 ( 推奨 )

OS　　: Windows2000/XP/Vista/7(32bit/64bit 版）

4. 接続方法
4.1. TAP モード （モニター及びキャプチャー）

TAP モードでは、 測定対象のネットワーク機器の間に LE-580FX を接続します。 測定対象のネットワーク回線

をポート A に、もう一方のネットワーク回線をポート B に接続し、ポート Aからポート B、及び、ポート Bからポー

ト A に送られている双方向のデータをモニター及びキャプチャーします。 測定されたデータは USB 経由でホスト

PCへ転送されます。

* ＬＡＮケーブルを１つのポートにだけつなぐとＮＩＣモードに、 ２つのポートにそれぞれつなぐとＴＡＰモードになり　

　ます。

測定ポート 10Base-T/100Base-TX Ethernet 2 ポート （RJ-45）

PC 接続ポート USB2.0　Ｈｉｇｈスピード　 （mini USB）

LED
電源 LED、 本体モード状態 LED、 ポート A Link/Tx LED、

ポート A Rx/Err LED、 ポート B Link/Tx LED、 ポート B Rx/Err LED

電源 USB バスパワー  (MAX 3W)

周囲温度 0～ 40℃ ( 動作 )、　-10 ～ 50℃ ( 保存 )

周囲湿度 0～ 85% ( 動作 )、　0 ～ 85% ( 保存 )

寸法 ・重量 95mm× 75mm× 20mm、　約 180g

付属
ユーティリティ CD、 Mini-USB ケーブル、 USB 分岐ケーブル （※）、

保証書、　取扱説明書　
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4.2. PG モード （パケット生成）

パケットジェネレーション （PG） モードでは、 LE-580FX のポート A と Bが独立して稼動できますので、 LE-

580FX の１ポートまたは２ポートとテスト対象機器を接続します。 パケットジェネレーションとパケットアナライザー

機能は両方のポート毎に設定できます。

＜注意＞

上図のように本機のＡ， Ｂポートをネットワーク上のスイッチやハブの２つのポートに接続して使用するときは、

本機がＴＡＰモード時に２つのポートが本機内部でループ接続となり、 ネットワークのブロードキャストフレーム

などがスイッチやハブによって無限に転送され、 ネットワークに悪影響を及ぼす場合があります。

このような場合は、本機をＰＧモードに切り替えた後に、Ａ，Ｂポートへのケーブル接続を行い、ＰＧテスト後は、

速やかにＡ， Ｂポートのケーブルを外してください。

4.3. USB 分岐ケーブル

LE-580FX の動作が安定しない場合には、 バスパワーの不安定が原因として考えられます。 付属の USB分岐

ケーブルを追加することで、 バスパワーの安定化を図れます。

 

＜手順＞

ステップ 1 : 先に USB 分岐ケーブルの端子 （オス側） 2 本を、 ホスト PCの USB ポートに差し込みます。

ステップ 2 : 次に USB 分岐ケーブルの端子 （メス側） 1 本を、 LE-580FX 本体の USB端子と接続します。



-14-

5.1. LE-580FX Window
LE-580FX Window では TAP モードや PG モードに切り替えて使う事ができます。 ラインレートのトラフィックを生

成できる PG モードや双方向のパケットをキャプチャーできる TAP モードを利用して様々なネットワークの解析が

できます。

5.1.1. 機能一覧 （英語 /日本語表記）

注） LE-580FX Window の詳細については、 付属 CD内の PDF をご参照ください。

5. アプリケーションソフトウエア

LE-580FX には、LE-580FX を制御するためのソフトウェア LE-580FX Window と、レイヤ２の QoS テストを行うソフトウェ

ア LE-580FX QoS の計 2種類のアプリケーションソフトが用意されています。

File/ ファイル

=> Load Default Workspace

/ 初期設定の読み込み

デフォルトのワークスペース設定の読み込み

=> Load Monitor Log

/ チャートログを開く

ダッシュボードで保存されるチャートファイル （トラフィック、フィルタ、

エラーの各グラフ） の読み込み

=> Exit/ 終了 LE-580FX Window の終了

Edit/ 編集

=> Cut/ 切り取り テキストの切り取り

=> Copy/ コピー テキストのコピー

=> Paste/ 貼り付け 切り取り ・ コピーしたテキストの貼り付け

View/ 表示
=> Alarm Info/ アラーム情報 閾 ( しきい ) 値をベースにアラーム情報を表示

=> Control Window/　コントロールウィンドウ コントロールウィンドウの表示

Capture

/ キャプチャー

=> Capture Setup/ セットアップ => Port A/B キャプチャー条件を設定

=> Capture Window/ ウィンドウ (=> Port A/B) データのキャプチャーを開始 ・停止 ・表示 ※ ( ) は PG モード時

=> Capture Option/ オプション キャプチャーファイル (.enc) を開くソフト (Ethereal/Wireshark) を選択

Media Type

/ メディアタイプ

=> Set Media Type

/ メディアタイプの設定

(=> Port A/B) Port A/B のスピード ・ 全二重 /半二重の変更

Statistics

/ 統計解析

=> Meter/ グラフ表示 => Dashboard 

/ ダッシュボー

ド

最新のトラフィック情報のリアルタイム表示

=> Threshold

/ 閾値設定

トラフィックの閾値を設定

=> Counter Window/ カウンタウィンドウ パケットに関連するカウンタ統計の表示

PG/ PG

=> Matrix Setup/ 送信パケット設定 => Port A/B TX パケット情報を設定

=> X-Trailer/ X-Trailer => Port A/B Port A/B の X-trailer を設定

=> Flow Control/ フロー制御 => Port A/B フロー制御の有無を設定

=> Rx BERT/ BERT 受信 => Port A/B Port A/B の Rx ビットエラーレートテストの有無を設定

Tools/ ツール

=> IFG Converter/ IFG 計算 TX IFG におけるインターフレームギャップの計算

=> Device Info/ アナライザー情報 メインウィンドウの左下に LE-580FX デバイスの情報を表示

=> FPGA Download/ FPGAダウンロード FPGA のバージョンアップ

=> Language/Language 日本語と英語表示の切り替え

Help/ ヘルプ => About/ バージョン情報 LE-580FX のバージョンの表示 （ソフト ・ ハード）
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5.2. LE-580FX QoS

LE-580FX QoS を利用してレイヤ 2の QoS （Quality of Service） の確認試験が容易にできます。

試験した結果は、 見易いグラフと数値で表示されます。

5.2.1. 機能一覧

注） LE-580FX QoS の詳細につきましては、 付属 CD内の PDF をご参照ください。

File
=> Load 保存したログファイルを表示する

=> Exit LE-580FX  QoS を終了する

Configuration         
=> Set Test Configuration テストの設定をするウィンドウを表示する

=> Set Chart Color 表示カラーを編集するウィンドウを表示する

Test
=> Test Panel 表とグラフで結果を表示する

=> Detailed Counter 2 ポートの詳細な統計を表示する

Help => About LE-580FX のバージョンを表示する （ソフト ・ ハード）
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6. LE-580FX Window の利用

6.1. パケットジェネレータ （PG モード）

パケットジェネレータは、 予め設定したパケットストリームを生成して、 ネットワークに負荷をかける他、 エラーフ

レームを送信することもでき、 ネットワーク装置の試験やネットワーク開通試験に利用できます。

＜設定例＞

LE-580FX のポート A が 10% の稼働率で、 64 バイトの ARP パケット通信を生成させ、 ポート B でトラフィックを受信す

る場合の設定を解説します。

＜手順＞

ステップ 1　:　コントロールウィンドウ ( 画面左 ) の 「PG」 ボタンをクリックし、 LE-580FX を PG モードにします。

ステップ 2　:　メニューの PG => 送信パケット設定 => Port A を選び、 Port A の Matrix Setup ウィンドウを表示します。

　　　　　　　　 フレーム番号 No.1 の Pattern(Byte) 欄をクリックすると、 「フレームの編集」 ボタン

 
 が出てくるの	

	   で、 これを押して 「フレームの編集」 を開き、 パケット情報を編集します。

	 　「OK」 をクリックすると設定が確定します。

ステップ 3 : 「フレームの編集」 のメニューのフレームタイプにて ARP を選択し、 必須情報MAC source や

　　　　　　　MAC destination などを入力します。  

注） 各プロトコルの詳細につきましては、 それぞれの規格書をご参照下さい。

Port A 側のフレーム 1 を選択 「フレームの編集」 を開くPG モードの選択

（PG ボタン）

インターフレームギャップの設定
すべてのフレームタイプ

を選択

フレームタイプを選択
生データを入力

選択したフレーム情報ヘッダを入力

送信レートの設定

フレームギャップの調整

フレーム送信回数の設定
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ステップ 4 : インターフレームギャップ (IFG) を設定します。 レート枠で 10 を選択し 「適用」 ボタンを押して、 稼働　

　　　　　　　　率を 10% に設定すると、 Matrix Setup ウィンドウの Frame gap 欄に 100M モードでのフレームギャッ　

　　　　　　　　プ "6144” ビットタイムが表示されます。

ステップ 5 : フレーム設定が終了したら、 「送信モード」 を 「連続送信」 に設定し、 「全て適用」 を押して、 すべ　

　　　　　　　　ての設定を確定させます。 Matrix Setup ウィンドウ上にある開始ボタンアイコン （緑色矢印） を押し　

　　　　　　　　て対象のトラフィックを送信します。

ステップ 6 : トップメニューから 統計解析 => グラフ表示 => ダッシュボードを選びダッシュボードウィンドウを開き

　　　　　　　　ます。また、 統計解析 => カウンタウィンドウを選んでCounter Window を開き、ポート A(Tx側 ) とポー

　　　　　　　　ト B(Rx 側 ) のパフォーマンス情報を表示します。

注） 送信ポート側では、 送信したパケットのキャプチャーはできません。

ステップ 7 : テストを停止するには Matrix Setup ウィンドウ上にある停止ボタンアイコン （赤四角） を押し、トラフィッ

　　　　　　　クの送信を停止します。 （「送信モード」 の 「送信パケット数」 で送信数を指定した場合は、 設定数　

　　　　　　　だけ送信した後、 自動的に停止します）。

注） 不適切なテストトラフィックの送信は、 ネットワークが妨害される原因になりますので、 ご注意ください。

　　＜参考＞

Matrix Setup （Port A/B） :

LE-580FX の 1 つのポートからは、 最大 128 パケットストリームを生成することができます。 ユーザー

はフレームの長さ、 内容、 インターフレームギャップを設定し、 様々なエラーを付加することができます。

送信パフォーマンスはダッシュボードやカウンタウィンドウで表示できます。

フレームの編集 ( ポート A/B):

Matrix Setup ウィンドウ中のフレームエディタを使い、 あらかじめ用意されている特定のパケット ・ タイ

プ (IPv4、 TCP、 UDP、 ICMP、 IGMP、 IPX および ARP ※タイプによってはオプションでタグ VLAN や

MPLS を付与できます ) と、 パケット内容を編集することができます。

送信レート計算 :

パケット間のインターフレームギャップはビットタイム単位で調整されます。 「送信レート計算」 では送信

の稼働率が計算できます。

ダッシュボードカウンタウィンドウ
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6.2. ネットワークモニタ （TAP モード）

LE-580FX が TAP モードで接続されている場合、 LE-580FX は TAP デバイスとして働き、 トラフィックをホスト

PC に転送します。 LE-580FX Window を起動してリンクパフォーマンスの観測や、 特定のトラフィックをモニター

することができます。

　　　　＜設定例＞

２局間の FTP リンク状態をモニターする場合の設定を解説します。

ステップ 1 : モニター対象の回線の間に LE-580FX を挿入します。 コントロールウィンドウの「TAP」ボタンをクリッ

　　　　　　　クし、 LE-580FX を TAP モードにします。 （デフォルトは TAP モード）

ステップ 2 : メニューの統計解析 => グラフ表示 => ダッシュボード からダッシュボードウィンドウを開き、 Port A

　　　　　　　(A → B) と PortB(B → A) のパフォーマンス情報をリアルタイムチャートで表示します。

＜注意＞

LE-580FX はフェイルセーフ機能を持たないため、TAP モード時に LE-580FX の電源が停止した場合はネッ

トワークが遮断されますので、 ご注意下さい。

リアルタイムトラフィックチャート

ダッシュボード

トラフィックカウンタレポート  ＆　アラーム

トラフィック量

トラフィックの方向
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ステップ 3 : メニューの統計解析 => カウンタウィンドウを選択し、 Port A (A → B) と Port B (B → A) のカウン タ情報を

　　　　　　　表示します。

備考 : LE-580FX で表示されるカウンタの情報

レートカウンタ :

TX Packet Rate/Bytes Rate/Utilization、 RX Packet Rate/Bytes Rate/Utilization、

Filter 1 Packet Rate/Byte Rate、 Filter 2 Packet Rate/Byte Rate

総計カウンタ :

TX/RX Packets/Bytes、 Broadcast/Multicast/Unicast Packets/Bytes、 Pause Packet、 Packet with 

VLAN Tag、 Sequential/TCP Checksum/ IP Checksum/CRC/Alignment/Dribble Error、 RUNT、

Oversize、 Fragment、 Jabber、 Lower/Upper Bound Counter、 Size Distribution Counter、 ARP 

Request/Reply、 ICMP Request/Reply

コントロールバーで、 カウンタのクリアー ・開始 ・停止や、

カウンタのセルサイズを調整

カウンタウィンドウ
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6.3. LE-580FX Window キャプチャー機能 （TAP モード）
TAP モードでは、 キャプチャー => セットアップでキャプチャーするパケットを選択する事ができます。

＜手順＞

ステップ 1 : TAP モードにします。

ステップ 2 : （キャプチャー設定）キャプチャー => セットアップ => Port A (PortA→ PortBのトラフィック )からキャプチャー

　　　　　　　タイプを選び、 「適用」 ボタンをクリックします （「保存先」 で保存先を指定できます）。 　

ステップ 3 :  キャプチャー => ウィンドウ => Port A を選ぶとキャプチャーウィンドウが現れます。 キャプチャーウィンドウ上

　　　　　　　の開始ボタン ( 緑色矢印 ) を押すとキャプチャーが開始され、 キャプチャータイプに合ったパケット   がホスト

　　　　　　　PC に送られます。

	 　　 LE-580FX はハードウェアベースのフィルターなので、 パケットがフィルター条件に合わなければホ スト PC

　　　　　　　には送られません。 キャプチャー停止ボタンを押すと、 キャプチャーウィンドウにキャプチャーしたパケット

　　　　　　　情報が表示されます。

	 　　キャプチャーされたファイルは、 より詳細なプロトコル解析のために Ethereal や Wireshark など他のソフトへ

　　　　　　　エクスポートすることができます。  

* ＴＡＰモードでキャプチャーできるパケットのサイズは、 60 ～ 1514 バイト （ＣＲＣを抜いたサイズ） です。

*Ethereal/Wireshark は LE-580FX Window よりもキャプチャー能力に優れているので、 パケットのキャプチャーを重視

　する使用目的の際は、 Ethereal/Wireshark を推奨します。

キャプチャーセットアップ ウィンドウ

キャプチャーウィンドウ

コントロールバーでパケットページを表示し、 キャプチャーを開始 ・停止

キャプチャーしたパケット

パケットデータ

パケットアナライザウィンドウ



-21-

備考 : LE-580FX でキャプチャーしたデータを Wireshark や Ethereal で表示することができます。

　　　以下は、 Wireshark での説明となります。

＜手順＞

メニューのキャプチャー => オプションにて Wireshark を選択します。

 キャプチャー => ウィンドウ をクリックし Capture Window を起動します。

続いて、 次の手順で進めます。

1)  Start Capture をクリックし , キャプチャーを開始します。

2） Stop Capture をクリックしキャプチャーを終了します。  

3） Next Page/Previous Page ボタンをクリックし、 Wireshark で表示するキャプチャーデータを表示します。

４） Invoke Wireshark をクリックし、 Wireshark でキャプチャーログを表示します。
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7. 他のネットワークアナライザソフトでの利用
LE-580FX は、 他のネットワークアナライザでも使用できます。 この場合、 LE-580FX は TAP デバイスとして働き、 リ

ンクトラフィックを PC に送ります。 下記は、 Wireshark で LE-580FX を TAP として利用する例です。

※弊社ＨＰ （http://www.lineeye.co.jp/） 上から LE-580FX TAP Mode Utility がダウンロードできます。 LE-580FX TAP   

       Mode Utility は、 サードパーティ ・ ソフトウェアを使い、 LE-580FX を 2 つの測定対象デバイス間の Ethernet TAP　

　   として使う場合に、2 つの測定対象デバイスの片方又は両方のメディアタイプが固定しかサポートしていない時 ( 例

       えば 100M Full 固定、 又は 10M Full 固定 )、 両方の対象デバイスが LE-580FX によって正しくリンクされるようにす

       る為に必要となります。

＜注意＞

LE-580FX は WinPcap Ver 4.1.1 でのみ動作いたします。 他のバージョンでの動作は保証されておりせんので

Ethereal や Wireshark のインストール時にはご注意下さい。

＜手順＞

ステップ 1 : Wireshark を立ち上げ、 Capture => Interfaces を選ぶと、 Wireshark Capture Interfaces Window の中に

　　　　　　　　 LE-580FX デバイスが現れます。

ステップ 2 : 「Capture」 ボタンをクリックし、 トラフィックのキャプチャーを開始します。

ステップ 3 : キャプチャーをストップし、 詳細なパケットの解析を確認します。   
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8. 保証とアフターサービス

保証

◆　この製品には保証書が添付されていますので、 お買い上げの際お受け取り下さい。

◆　所定の事項の記入および記載内容をお確かめの上、 大切に保管してください。

◆　保証期間は、 お買い上げ日より 1年間です。

アフターサービス

◆　保証期間中の修理は、 保証書の記載内容に基づいて修理させていただきます。

           詳しくは保証書をご覧ください。

◆　保証期間経過後の修理は、 修理によって機能が維持できる場合、 ご要望により、 有償修理させていただきます。

※修理についてご相談になるときは、型名、製造番号、故障の状態 （できるだけ詳しく）、購入年月日をお知らせください。







● 本社 ：〒６０１－８４６８　京都府京都市南区唐橋西平垣町３９－１ 丸福ビル５Ｆ

　　　　　　　TEL:075(693)0161                             FAX:075(693)0163

● 技術センター ：〒５２６－００６５　滋賀県長浜市公園町８－４９

URL http://www.lineeye.co.jp　 Email :info@lineeye.co.jp

この取扱説明書は再生紙を使用しております。

　Ｐｒｉｎｔｅｄ　Ｉｎ　Ｊａｐａｎ

　M-72580J/LE


